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1 Summary

The Calidus 3pl-Mobile database can be accessed for client reporting purposes using a Microsoft-standard ODBC data
connection.

The suggested mechanism for accessing the data is:

1. Create a link database
2. Create an ODBC Data Source
3. Get the data from the ODBC data source with Microsoft Excel

Ready for What’s Next, Now™



External Data Access v11.1

2 Detalls

2.1 Set-up Requirements
The Calidus 3pl-Mobile system must be set up for your data.

You must have access to the logging database. This document assumes that this has been created under a network drive
X:

2.2 Create a Link Database

In order to minimise the impact of the query on the Calidus 3pl-Mobile system, this should be performed on a link
database. It is possible to access the database directly, but this is not recommended by OBS.

Create a new Access database.

Microsoft Access o ]
- Flle Edit Wiew Insert Tools  Window  Help Tvpe a question for help =

DB ESRAY iR %R |F =06 0.

4 % New File v x

Open a file
dbl.mdb

QBSMEWD . mdb

rdtl . mdb

rdtl_struct. mdb
= More files..,

New
Elank Database
EBlank Data Access Page
Project {Existing Data)
Project {Mew Data)

New from existing file
@ Choose file. ..

New from template
General Templates. ..
Templates an Microsaft, com

£ add Mebwork Place. .,
El Microsoft fccess Help
Shows at starkup

Ready M 4

This database can be created locally (or your PC) if this is only being used by you, or can be created on any network
machine (for example, the WCS Server) if used by many people.

) Ready for What’s Next, Now" V22227274
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File New Database

Save in: I@ My Documents =] & - | & X ~ Tools ~

4 |RDC Connections
Favarites

File name: IWCS—Reporting.mdb j Create I
Save as fypet IMicrosoft Access Databases (*.mdhb) j Cancel I
4

In this case this has been called WCS-Reporting.mdb, created in My Documents

=1al

| Bl | BdE Wew  Insert Tods  Windaw  Bep Type aqueston for leb =
- G- g 00| R - | ),

Database Properties

1 WCSRepartingmdb

Zdbt.mib

2 Documents and Setongsl. . OESMEWG mdb
4 WEPrograms|3_#ibatasasslict ! mdb

Egt

Py pLP

Choose Get External Data/Link Tables from the File menu.

3 Ready for What’s Next, Now" V22227274



Loak in:

Hiskory

My Documents

Favarites
=)
], 52

Tty Nebwark
Places

I ] Database

2]

& -E @ X O - Teos-

[ rdt1.mdb
@rdtl_emptv.mdb
[#1]rdt1_PLAT mdb
@rdtl_struct.mdb

File: marne: I

Files of kype: IMicrosoft Access (*.mdb;* mda;* . mde)

Link I

Cancel I
4
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Link to your Calidus 3pl-Mobile logging database. This is normally in X:\Log.mdb or X:\Log1l.mdb.

Tables |

Error Log
Exceptions
Incoming Log
|oukgoing Log

Cancel |
Select all |
Deselect All |

Link the table ?RDT Activity?

Ready for What’s Next, Now™
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Microsoft Access i ] 5

Tvpe a question for help =

File Edit ‘Wew Insert Tools Window Help

Ny GRY | {2R oK

BB~ | % 00 5 o8& - | 3.

gE WCS-Reporting : Database (Access 2000 file format)
L open [ Desian i New | * | 8y T

Objects Create tahle in Design view

Tables Create table by using wizard

Create table by entering data
[=R0T Activity

Queries
Forms
Reparts
Pages

Macras

& O EE B D

Modules

Groups

(3] Favorites

Reeady M v

Save your new database by closing Access.

2.3 Create an ODBC Data Source
Choose Start/Settings/Control Panel/Administrative Tools/Data Sources (ODBC) from the Start menu.
If this option is unavailable on your PC, you must have an Administrator user do this for you.

TIODBC Data Source Administrator e

ser DSH  Spstern DSM | File DSM | Driversl Tracingl Connection F'oolingl Aibout I

Spstem Data Sources:

Mame | Driver | Add... |
IBM IMFORMIX 3.82 32 BIT
Bemove |

LConfigure...

An ODBC Spstem data source stores information about how to connect o
the indicated data provider. 4 Spetemn data zource is vigible to all ugers
o this machine, including NT services.

ak. I Cancel Lpply Help

Create a new System DSN

Ready for What’s Next, Now™ Y222227 4
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Create New Data Source ﬂ

Select a driver for which pou want to get up a data source.

Name <
Diriver da Microzaoft para arguivos testo [7 bt * cav)
Dinver do Microzoft dccess [*.mdb] =

Drriver do Microzoft dB ase (*.dbf)
Dinver do Microzoft Excel(* xlz)
Diriver do Microzoft Paradox (*.db )
Driver para o Microsoft Visual FoxPro
|BM IMFORMI= 3.82 32 BIT
Mic [ Jriver [*.mdb)

Microzoft Access-Treiber [+ mdb)
hdjmtmendt AD sea Miivsar (5 ARF i
4 I I L3

< Back I Finizh I Cancel

Choose ?Microsoft Access Driver (*.mdb)?.
If this option is unavailable on your PC, the Microsoft Data Access Components (MDAC) must be installed on your PC.

ODBC Microsoft Access Setup ' e |

Data Source Mame: |WCSHF‘T k. I
Description: IWES Reporting Database
Cancel |
— Databasze
Datahase: Help |
Select... | Create... | Bepair... | Compact... |
Advanced... |

— System D atabasze

' Mone
" Database:

System [Database.,. |
Dptionss > |

Ensure the Data Source Name is 8 characters or less.

Select your data source using the ?Select?? button.

select Database x|
Database Mame Directories:
WS -Reporting. mdb ch sy documents

Cancel |
Copy of dbl.mdb ;I = walkert. UK-PwL ;I
db'l ondb = My Documents |
i Reporting.mdb £ Fax J L2l

8 Pw I~ ReadOnl
3 My Data Source Lt

ﬂ £ My Labels

ﬂ I Erclusive

List Files of Type: Dirives:

I.&ccess Databazes [*.muj I B o LOCAL DISK j Hetwark... |

Click ?0K? to save the new data source

5 Ready for What’s Next, Now™
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£710DBC Data Source Administrator 2 x|

User DSM  System DSN | File DISM | Driversl Tracingl Connection F'oolingl About I

System Data Sources:

| Driver | Add... I

W IEM INFORMIx 3,82 32BIT

ESF!F'T Micrazoft Access Driver [*.mdh) Remove |
LConfigure. .. |

An ODBC Spstem data source stores information about how to connect ta
the indicated data provider. A& Spstem data source iz vizible to all users
onh this machine, including MT services,

ak. Cancel Lpply Help

2.4 Access the Data in Microsoft Excel
Now that this is set up, you can access the Calidus 3pl-Mobile logging data from external sources. In this example, this is

from Microsoft Excel, but could just as easily be from any ODBC-compliant reporting tool, such as Crystal Reports or
Cognos Impromtu.

Open Excel and create a new workbook.

FA Microsoft Excel i ] |
- Fle Edit Wew Insert Format  Tools Data  Window  Help functions -
DEEeu/SR Y| s @b o @@ o - 0.

S Eilker Y E 5=

: prial -1 -|B I U B E = - d AL

B Farrn..

MEE P cEEA|

A1 3 Subtokals. ..

Walidation. ..

Table...

Text ko Colurmns, ..

Consolidate, .,

Group and Cutline

PivotTable and PivotChart Report...

Import External Data

Refresh Data

=

—
[{u]

4 4 » w]Sheet1 / shestz £ sheets /

Ready MU ~

Choose Import External Data/New Database Query from the Data menu.

At this point, you may be prompted to install Microsoft Query for Excel. This may have to be completed by an
Administrator.

; Ready for What’s Next, Now™"



Choose Data Source

Databases I C!ueriesl OLAF Cubes

<Mew Data Source>
dBASE Files®

Ercel Files™

MEIS*

M5 Access Databasze™
Supimix®

izual FoxPro D atabase®
"igual FouPro T ables”

Cancel

Delete

@l ¥ Use the Query \Wizand to creatededit queries

Browse...

Optians....

dadil

Choose the WCS Reporting Data Source we set up earlier.

Query Wizard - Choose Columns

‘What columnz of data do you want ta include in your gueny?

Available tables and columns:

5

Prewview of data in gelected column:

> | Start
4

LColumns in your querny:

End
Activity
Madule
Compary
W arehouse
RDT
Employes

@I EreviewNowl Optionz... |

< Back I Mext > I

Cancel |

Choose the table to report. In this case, you will want the RDT Activity table.

Query Wizard - Filter Data

Filter the data to specify which rows to include in your guen.
If pou don't want to filker the data, click Mext.
Column ta filker: Only include rows wherne:

r Start

End
Aictivity
Madule

Iis areater than

=] [zo08-11-21
& And O O

Company
Warehouse
RDT
Employes

=l

 And €000

Pallet ID I
Cust Pallet No
CwnerCode x|

=

© And 0

=)

< Back I Mext » I

Choose the data you want to filter.

Query Wizard - Sort Order

Specify how you want pour data sorted.
If pou don't want to sort the data, click Nest.

Sort by

% Ascending
" Descending

) Sscending
. Descending

) Sscending
) Descending

YI

< Back I Mext » I

Cancel |

Ready for What’s Next, Now™
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Choose the Sort Order

Query Wizard - Finish

x|

—"what would you like to do next?

" View data or edit query in Microsoft Query
™ Create an OLAP Cube from this query

& Retun Data to Microsoft Exoet Save Huery... |

@l <Back [ Finsh |

Cancel

Return the data back into Excel.

Where do you want to put the daka?
" Existing worksheet: I
Zance
Ere——
" New worksheet
[i7 Creste a PivatTable report...
Properties. .. | Parameters. .. I Edit Query... |

Choose the cell into which you want the data to be loaded.

Fd Microsoft Excel

Fil= Edit Wew Insett Faormak Tools Data  Window  Help
DeEdaqn SaY §
arial - 10 - I ul=

Meed VeEoeEEBA AR R,

+.0
00

A RETRAL Nl
B9 %,

.00
+.0

2

=131

functions

M 4% 100 - .

=101

6] H

Start IEnd Activity Module
211112006 08:44 21/11/2006 05:46 Receipt | RECPT
2171172008 09:43 21,/11/2006 0343 Mave MOWE
2171142008 09:43 21,/11/2006 03:43 Mave MOWE
2171142008 09:43 21,/11/2006 09:50 Mave MOWE
2171172006 09:51 2141172006 0952 PutAweay | PAWAY
2111152006 0952 21/11/2006 02:52 Putfway |[PAWAY
211172008 12:20 211172008 12:20 Mave MOWE
211172008 12:200 211172006 1221 Mave MOWE
217112006 12:22 2141172006 12:23 PutAweay | PAWAY
217112006 12:25  21411/2006 12:25 Move MOWE
217112006 13:22 21411/2006 1322 Move MOWE
21/11/2006 13:23 2141172006 13:23 Move MOVE
21711/2006 14:37 2171172006 14:44 Receipt RECPT
21711/2006 14:55 2171172006 15:02 Receipt RECPT
21711/2006 15:14 2171172006 1514 PutAweay | PAWAY
217112006 15:14 2141172006 1514 PutAweay | PAWAY
217112006 15:15 2141172006 15:16 Move MOVE
2171172008 15:168 211172008 1516 Mave MOWE

Company Warehouse RDT Employee

DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL
DHL

4 4 » M[%Sheetl i sheetz & sheetd

Ready

W1
W1
W1
W1
W1
W1

W1
I |

MM

Once the data is loaded in the form, you can filter and format the data in any way you want.

9 Ready for What’s Next, Now™"
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Ed Microsoft Excel
Fle  Edit

DEESH SRV &6

Wiew Insert  Farmat

Aial - 10 -

©

Tools

B I U =

Data

H

indow

Help
-F oo - @ E - 8] Z] |l 4 oo
B F %, Wil EL
M Ve cEEF2DAR R,

=0l

functions -

- B

d

K

Start Activit -

Employe =

Pallet | »

Cust Pallet Ho

Owner Cot ~

211172006 03:44 Receipt
211172006 02:48 Mave
2111172006 02:49 Mave
2111172006 02:49 Mave
211172006 02:51 PutAway
211172006 09:52 PutAway
211172006 12:20 MWave
211172006 12:20 Mave
211172006 12:22 PutAway
211172006 12:25 Maove
211172006 13:22 Maove
211172006 13:23 MWave
211172006 14:537 Receipt
2111172006 14:55 Receipt
211172006 15:14 PutAway
211172006 15:14 PutAway
211172006 15:15 Wave
211172006 15:16 hWave

1J
1J
1
1
1
1J
1J
1J
1
1
1
1J
1J
ADM
1
1
1J
1J

00000203
00000255
00000260
00000265
00000265
00000265
00000265
00000267
00000267
00000203
00000203

0ooooz7o
00000271
00000270
0000027 1

803082

803081

330576409624701472
330576405624701489
330576405624701472
3305764056247 01489
3305764096033007 58
3305764096033007 58

330576409624701441
330049000628501702
330576405624701441
33004900062G501702

M4 4 » M]Sheetl

Sheetz £ sheets /

Ready

141

Dos
Dos
Dos
Dos
Dos
Dos
Dos
Dos
Dos
Dos
Dos

MM v

Fd Microsoft Excel
Fil=  Edit

Dedst SRV &8I

View  Imsert  Farmat

avial - 10 - I

©

Tools

Data

L1

H

Window

Mg el v o & EHERF 2l 2 AR

O] x|

Help functions -
IR S A Y R
B 9%, 4% &4 DA,

=101

d

K N

Activit »

Employe ~

Pallet ]

Cust Pallet No

Owner Coc « |Stock Col_

211172006 05:44 Receipt
211172006 02:48 Mave
2111172006 02:49 Mave
211172006 02:49 Maove
211172006 09:91 PutAway
211172006 09:52 PutAway
211172006 12:20 Mave
2111172006 12:20 Mave
211172006 12:22 PutAway
211172006 12:25 Maove
21172006 13:22 Wave
211172006 13:23 Mave
211172006 14:537 Receipt
2111172006 14:55 Receipt
211172006 15:14 PutAway
211172006 15:14 PutAway
211172006 15:15 Wave
211172006 15:16 Mave

1J
1
1
1
1J
1J
1J
1
1
1
1J
1J
1
AL
1
1J
1J

1J

00000203
00000255
00000260
00000265
00000265
000002658
00000263
00000267
00000267
00000203
00000203

00000Z70

00000271
00000270
00000271

Dos
803082 Dos
803081 Dos
330576405624701472 D05
330576405624701459 D05
330576405524701472 D05
3305764096247014589 DOS
330576409603300788 D05
330576409603300788 D05

Dos

Dos

330576409624701441 DOS
330049000623501702 D05
330576405624701441 DOS
330049000523501702 D05

4 4 » M[|Sheetl ; shestz

Ready

Sheets

14

0
000

000

g907
g907
8207
g907
g907
g907
9081
2051

ML £

The sheet will retain its formatting.

You can then save this worksheet for running in the future.

10
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2.5 Adding Parameters

Parameters allow you to specify the data to be returned ?on the fly? by saying what you want it to match.

Choose Import External Data/Edit Query from the Data menu.

Keep hitting Next until you get to the end of the query, then click on the ?View Data in Microsoft Query? option, before
clicking Finish.

|

Query Wizard - Finish

—what would vou like ta do nest?

" Retumn Data to Microsoft Excel

Save Huery... |

" Miew data or edit query in Microsoft Duers

@I < Back I Finizh I Cancel

You will be taken into the Microsoft Query application.

_|ol x|
File Edit Yew Format Table Criteria Records ‘Window Help
' [Ple¥F] [l [F=[ =]
=1o) x| =
Activity
Compary
Cust Batch
Cust Pallet Mo
Employes i
P I I T "
Criteria Figld: | Start | Company [Wwarshouse
Walue: | >4#21/11/20068 'DHL' 01"
or: T
‘ _>|J
| Start | End [ Activity [Module Eompan_l,|Walehoust| RDT [ Employee | Palle «
i3 I 2006-11-21 08:46:35  Feceipt RECFT ' DHL w1 1 [A]
1 11-21 034856 | 2006-11-21 09:43:04  Move MOWE | DHL Wil 1 A 0ooogd—
_ | 2006-11-2103:49:48  2006-11-21 094957 Move MOWVE  DHL w1 1 Al 00000
_ | 200611-21 034955 2006-11-21 09:60:04  Move MOWE | DHL Wil 1 A 00o0o
_ | 2006-11-21 035137 2006-11-21 095201 Putéimay Paisiiy  DHL w1 1 A 00000
_ [ 2008-11-21 035214 2008-11-21 096215 | Putdway Pty DHL w1 1 1 0000g
| 200611-21 1220038 2006-11-21 122051 Move MOWVE | DHL Wil 1 A 00o0o
_[2008-11-21 122053 2008-11-21 12:21:01 b cover MOWE | DHL w1 1 1 0000g
_ | 200611-21 122243 2006-11-21 122303 Putdway Paisiiy' | DHL Wil 1 A 00o0o
| 200611-21 122507 2006-11-21 1225:38 Move MOWVE  DHL w1 1 Al 00000
_ | 200611-21 132224 2006-11-21 132242 Move MOWE | DHL Wil 1 A 00o0o
| 200E11-21 13 E2E2E 200611-21 132337 Move MOWVE  DHL w1 1 Al 00000
_ | 200611-21 143786  2006-11-21 14:44:03  Receipt RECFT | DHL Wil 1 A
_ | 2006-11-21 145505 2006-11-21 1500258 Receipt RECFT  DHL w1 7 ADM T
_ [ 2008-11-21 151419 2008-11-21 1514:25 | Putdway Pty DHL w1 1 1 0000g
| 200611-2115:14:40  2006-11-21 15:14:41 Put&may Paisiiy | DHL Wil 1 A 00o0o
_ [ 200811-21151%55 2008-11-21 1%16:08 Move MOWE | DHL w1 1 1 0000g
_ | 200611-21 151630 2006-11-21 15:16:33 Move MOWVE | DHL Wil 1 A 00o0o
_ | 2006-11-21 15:31:11 2006-11-21 15:31:14 | Pubbamay Faiddy'  DHL w1 1 Al onooo
. ARAC AT A AE AT ANAC A4 A1 AE A Pl e Pas e ane Ein e 1 N nnanm R
Select File Return Data to Microsoft Excel to return data to client application | | 4

Make sure the Auto-Query button (!) is not pressed in.

11
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;"‘. Microsoft Query i ] [
Eile Edit Wew Format Table Criteria Records Window Help
dol= =W [ [oFleF] Pl F[=] 242 L[] W3]
%y Query from WCSRPT - IEIlll =
RDT Activity
Ackivity
Compary o
Cust Batch
Cust Pallet Mo
E mployes 7
L T T T T T ”
Criteria Field: [ Start | Compary [ arehouse
Walue: | »4#21/11/20068 'DHL' 01"
ar: b
‘ _'l_I
] Start End | Activity [Module|Company] W arehousi| RDT [ Employee [ Palle «
na 2 4 2006-11-21 08:46:35  Feceipt RECFT ' DHL Wil 1 A
_ | 2008-11-21 094356 2008-11-21 09:49:04  Move MOWE | DHL w1 1 1 00000
| 2006-11-2109:49:48  2006-11-21 094957 Move MOWVE | DHL Wil 1 A 00o0o
_ | 2008-11-21 094359  2008-11-21 09.60:04  Move MOWE | DHL w1 1 1 0000g
| 200611-21 035137 2006-11-21 095201 Putéway Paiwiay | DHL Wil 1 A 00000
_ | 2006-11-21 035214 2006-11-21 095215 Putbway Faiddy'  DHL w1 1 Al 00000
_ | 200611-21 1220038 2006-11-21 122051 Move MOWE | DHL Wil 1 A 00o0o
| 200611-21 1220083 200611-211221:01 Move MOWVE  DHL w1 1 Al 00000
_ [2006-11-2112:2243  2006-11-21 122303 | Putdway Paiwiay | DHL Wil 1 A 00o0o
| 200611-21 122507 2006-11-21 1225:38 Move MOWVE | DHL Wil 1 A 00o0o
[ 200811-21 1% 2224 2008-11-21 132242 Move MOWE | DHL w1 1 1 0000g
_ | 200E11-21 132326 2006-11-21 132337 Move MOWVE | DHL Wil 1 A 00o0o
_ | 2008-11-2114:37:56  2008-11-21 14:44:03  Feceipt RECFT  DHL w1 1 1
_ | 200611-21 145505 2006-11-21 150258 Receipt RECFT | DHL Wil 7 ADM -
| 200611-21 151419 2006-11-21 15:14:25  Pubdway Faiddy'  DHL w1 1 Al 00000
_ | 200611-21 151440 2006-11-21 15:714:41  Putéway Paiwiay | DHL Wil 1 A 00o0o
| 200611-21 151555 2006-11-21 15:16:08 Move MOWVE  DHL w1 1 Al 00000
_ |2006-11-21 151630 2006-11-21 15:16:33 | Mave MOWE | DHL Wil 1 A 00o0o
| 200611-21 153111 2006-11-21 15:31:14  Pubéuway Paisiiy | DHL Wil 1 A onood
Chooge Query Mow ta mn the querny and display results | 14
Choose the item you wish to parameterise.
;’“. Microsoft Query 10| x|
Eile Edit Wew Format Table Criteria Records Window Help
~ = A
ERIElTR (] (Bl Fel F=I=] A
' _loj x| =
Activity
Compary
Cust Batch
Cust Pallet Mo
Employes i
L T T T I T ”
Criteria Figld: [ Start | Camnpany [ arehouse IE mployed] =
Walue: | >4#21/11/20068 'DHL' "w/01"
ar: il
‘ _'l_I
Start End | Activity [Module| Company| W arehouse| RDT [ Employee | Palle «
b | 2006-11-21 0B:44:01 | 2006-11-21 08:46:35 | Receipt RECFT ' DHL w1 1 [A]
_ | 2008-11-21 094356 2006-11-21 09:49:04 Move MOWE | DHL Wil 1 1 0ooog——
| 2006-11-2109:49:48  2006-11-21 094957 Move MOWVE | DHL Wil 1 A 00o0o
_ | 2008-11-21 094359  2008-11-21 09.60:04  Move MOWE | DHL w1 1 1 0000g
| 200611-21 035137 2006-11-21 095201 Pubéway Paisiiy | DHL Wil 1 A 00o0o
_ | 200811-21 035214 2006-11-21 095215 Putbway Paiihy  DHL w1 1 Al 00000
_ | 200611-21 1220038 2006-11-21 122051 Move MOWE | DHL Wil 1 A 00o0o
| 200611-21 1220083 200611-211221:01 Move MOWVE  DHL w1 1 Al 00000
_ | 200611-21 122243 2006-11-21 122303 Putdway Paiwiay | DHL Wil 1 A 00o0o
| 200611-21 122507 2006-11-21 1225:38 Move MOWVE  DHL w1 1 Al 00000
_|2008-11-211%2224  2006-11-21 132242 Move MOWE | DHL Wil 1 1 00o0g
_ | 200E11-21 132326 2006-11-21 132337 Move MOWVE | DHL Wil 1 A 00o0o
_ | 2008-11-2114:37:56  2008-11-21 14:44:03  Feceipt RECFT  DHL w1 1 1
| 2006-11-21 145505 2006-11-21 1500258 Receipt RECFT ' DHL Wil 7 ADM T
| 200811-21 151418 2006-11-21 15:14:25  Putduway Paiihy  DHL w1 1 Al 00000
_ | 200611-21 151440 2006-11-21 15:714:41  Putéway Paiwiay | DHL Wil 1 A 00o0o
| 200611-21 151555 2006-11-21 15:16:08 Move MOWVE  DHL w1 1 Al 00000
_ | 200611-21 151630 2006-11-21 15:16:33 Move MOWE | DHL Wil 1 A 00o0o
2006-11-2115:31:11  2006-11-21 15:31:14 | Putduway Faiddy'  DHL w1 1 Al onooo
Select File Return Data to Microsoft Excel to return data to client application | 14

12
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L Microsoft Query i ]
File Edit %ew Format Table Criteria Records Window Help
EEEE HIEIEE
= Query from WCSRPT =10 x| =
RDT Activity
Ackivity =
Compary
Cust Batch
Cust Pallet Mo
Employes hd
o T T T T "
Critenia Field: [ Start [ Compary [Mw/arehouse [Emplayee
Waluer | »#21/11/20064 ‘DHL' w0 [Enter an Employes]
ar: b
: _>l_I
Start End [ Activity [Module| Company|'Warehous RDT [ Employee [ Palle «
_ | 2006-11-21 084400 2006-11-21 08:46:35  Receipt RECFT | DHL Wil 1 A
_ | 2006-11-21 034856 2006-11-21 09:49:04  Move MOWVE  DHL w1 1 Al onoao—
_ | 2006-11-21 034348 2006-11-21 094357 Move MOWE | DHL Wil 1 A 00o0o
_ | 200611-21 034953 2006-11-21 0950:04  Move MOWVE | DHL Wil 1 A 00o0o
_ [ 2008-11-21 03:51:37  2008-11-21 096201 | Putdway Pty DHL w1 1 1 0000g
| 200611-21 035214 2006-11-21 095215 Pubéway Paisiiy | DHL Wil 1 A 00o0o
_[200811-2112.20:38  2008-11-21 122051 Move MOWE | DHL w1 1 1 0000g
_|200611-21 1220083 2006-11-21 1221:01 Move MOWE | DHL Wil 1 A 00000
| 200611-21 122243 200611-21 122303 Putbway Faiddy'  DHL w1 1 Al 00000
_ | 200611-21 122507 2006-11-21 1225:38 Move MOWE | DHL Wil 1 A 00o0o
| 200E11-21 132224 2006-11-21 132242 Move MOWVE  DHL w1 1 Al 00000
_ |2006-11-2113 2326 2006-11-21 132337 Mave MOWE | DHL Wil 1 A 00o0o
_ | 200611-2114:3756  2006-11-21 14:44:03  Receipt RECFT ' DHL Wil 1 A
_ | 2008-11-2114:5%05  2008-11-21 150258  Feceipt RECFT  DHL w1 7 A0 _
| 200611-21 151419 2006-11-21 15:714:25 | Pubéway Paisiiy | DHL Wil 1 A 00o0o
_ [ 2008-11-2115:14:40 2008-11-21 1%74:41 | Putdway Pty DHL w1 1 1 0000g
_ | 200611-21 1515855 2006-11-21 15:16:08  Move MOWE | DHL Wil 1 A 00000
| 200611-21 151630 2006-11-21 15:16:39 Move MOWVE  DHL w1 1 Al 00000
_ | 200611-21 153111 2006-11-21 15:31:14  Putéwway Paiwiay | DHL Wil 1 A onood
Select File Return Data to Microsoft Excel to return data to client application | 14

Hit Enter. You will be prompted for an employee code in a popup box. Enter one.

Enter Parameter ¥alue

Enter an Employes

2]

|IJ

=]

Cancel |

You can now exit Microsoft Query and return the data to the Excel spreadsheet by clicking the X in the top corner.

13
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Ed Microsoft Excel =10/ x|

Fle Edit Wiew Insert Format  Tools Data  Window  Help parameter
DEE S8 SRy £ BR-<F o-o- @ -2 2] @040 -3
Al R o= B ®%, 9% &=
M| Ve rEEP2IAR R,

A2 - t:‘z

A © H | d K
1 |Start = | Activit = |[Employe = |Pallet | » |Cust Pallet No Owner Coc ~
8 | 211172006 09:49 MWave 1J 00000260 508051 Dos
B | 21/11/2006 09:51 PutAway |1 00000268 330576409624701472 Dos
7| 211172006 09:52 PutAway |1 00000268 330576409624701489 Dos

8 | 21/11/2006 12:20 Mave 1 000002658 330576409624701472 Dos
9 | 2171172006 12:20 Maove 1 00000265 330576409624701489 Dos
|10 | 211142006 12:22 PutAway (1 00000267 330576409603300755 Dos

21172006 12:25 MWave 1J 00000267 330576409603300755 Dos
211172006 13:22 Mave 1J 00000203 Dos
21112006 13:23 Move 1 00000203 Dos
21112006 14:37 Receipt |l
21112006 15:14 Putdway |1 00000270 330576409624701441 Dos

2
3
4
5
6| 21/11/2006 15:14 Putdway (1) 00000271 330045000625501702 Dos
7
g
9

211172006 15:15 Mave 1J 00000270 330576409624701441 Dos

21112006 15:16 Move 1 00000271 330042000628501702 Dos

1

21112006 15:31 Putdway |1 00000272 330576409624701519 Dos
20 | 21/11/2006 15:31 PutAway (I 00000273 330576409624701526 Dos
2

1211142006 15:32 Move 1J 00000272 330576409624701518 Dos

22 | 217112006 1540 hove A Q0000273 3505764096524701626 o5
4 4 » w]\Sheetl { Sheet? £ Sheetd / 14

Ready TR
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The data is now selecting only the tasks relevant to employee 1J. Whenever you refresh the data, the Employee will be

prompted:

Enter Parameter ¥alue ﬂil

Enter an Emploves

| X

™ Use this value/reference for fukure refreshes

[T Refresh automatizally when cell value changes

ok, I Cancel |

You can add multiple parameters to a query. Each will be prompted for in turn.

Note: You have full help on how Microsoft Query works, available using the Help button on the Query forms.

" Ready for What’s Next, Now™"
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=

M e &= =

Contents  Answer Wizard IlndeH I

= Show All 2
About using Microsoft Query to retrieve external data
What would you like to do? This topic contains information about:
wWhat is Microsaft Query?
Setting up data sources

Defining vour guery
YWarking with the data in Microsaft Excel

Select topic ko display: —

what is Microsoft Query?

Microsaoft Query is a pragram For bringing data from external sources inka other Micrasaft OFfice programs —in
particular, Microsoft Excel, By using Query bo retrieve data from wour corporate databases and files, you don't
have to retype the data you want to analyze in Excel, You can also update wour Excel reports and summaries
automatically From the original source database whenever the database is updated with new information.

Types of databases you can access ‘You can reftrieve data from several bypes of databases, including
Microsoft Access, Microsoft S0L Server, and Microsoft SQL Server OLAP Services, You can also retrieve data
Fram Excel lists and from text files, See a list of types of databases vou can access,

In Excel, vou can also retrieve data from Web pages, but vou don't need Query to do this, For information
about retrieving data From Web pages, see Excel Help.

5Selecting data from a database ou retrieve data from a database by creating a query, which is a
question you ask about data stored in an external database, For example, if vour data is skared in an Access
database, you might: wank to know the sales figures For a specific product by region. You can retrieve a part of
the data by selecting only the data for the product and region ywou want bo analyze and omitting the data you
don't need,

Ayailable tables and columns:  Columnsin :
[ESales by Category | Categary :

ElSales by Region Fegion (1
Salesperzon Amount T
Customer IO !

Search on Web |

2} 1 [Category | Region ."-\mount!

Beuerages : LI

1. 1. WCS File Layout

RDT Activity table

Move Qty Mumber Amount on pallet when moved
Reference Text Reference under which paliet was moved|

15 Ready for What’s Next, Now™
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